
Timbuktu Pro for Mac OS, version 8 At a Glance

Starting Timbuktu Pro

By default, the Timbuktu Pro Host is launched automatically when 
you start your Macintosh. To work with Timbuktu Pro or establish an 
outgoing connection, click the application icon (located by default 
on the menu bar in the upper-right corner of your screen) and 
choose Open Timbuktu Pro.

The Timbuktu Pro Host is started automatically whenever you start 
your Macintosh unless you have turned on the Only Accept Incoming 
Connections When Application is Open option on the General tab in 
the Preferences dialog box. If this option is enabled, Timbuktu Pro 
will not start automatically. To start Timbuktu Pro, open the 
Timbuktu Pro folder and double-click the Timbuktu Pro icon.

Selecting a Remote Computer

Before you can use any Timbuktu Pro service 
with a remote computer, you must establish a 
connection with the New Connection window. 
Click the File menu and choose New Connection.

In the New Connection window, choose a con-
nection tab—Address Books, Dial Direct, Rendez-
vous, TCP/IP, or TCP/IP Scanner— to start the 
connection procedure.

You can establish a Timbuktu Pro connection to 
a remote computer by entering its IP address, 
domain name, or email address on the TCP/IP 
tab. Use the Rendezvous tab to search for active 
Timbuktu Pro computers. You may also use the 
TCP/IP Scanner tab to search your network for 
the computer you want, or enter its phone num-
ber on the Dial Direct  tab to make a direct mo-
dem-to-modem connection. As long as you have 
been granted access you can connect to any 
computer that is running Timbuktu Pro. 

Using Address Books
An address book is a collection of Timbuktu Pro addresses you can use to keep your favorite addresses organized. 
Once you have added an address to your address book, you don’t have to re-enter it each time you connect to that 
computer. Simply select it and choose a service from the Service menu or the Button Bar.

To add addresses to an address book, first make sure the desired address book is open. To open an address book, 
choose its name from the File menu.

1. In the New Connection window, select a computer on the TCP/IP Scanner tab, enter an address on the TCP/IP 
tab, or enter a phone number on the Dial Direct tab.

2. From the Service menu, choose Save in Address Book.



Using Timbuktu Pro Services

Using Send

The Send service lets you send messages, files, and 
folders to remote computers. 

1. In the New Connection window, select the remote 
computer.

2. From the Service menu, choose Send. Or click the 
Send service button. 

3. In the Log In dialog box, log in as a Registered 
User or Guest User, or ask for permission.
The Send window is displayed. 

4. Type a message in the Message panel. 
5. To include files with your message, click the Add 

button. Or drag and drop files and folders from 
the desktop into the Enclosures area in the Send 
window.

6. In the Add Files or Folder dialog box, navigate to 
and select the files or folders you want to add, 
and click the Add  button. 

7. Click the Send  button in the Send window to 
send the FlashNote and files. 

Using Exchange

With the Exchange service, you can copy and move 
files and folders in both directions between your 
computer and another Timbuktu Pro computer.

1. In the New Connection window, select the 
remote computer.

2. From the Service menu, choose Exchange. Or 
click the Exchange  service button.

3. In the Log In dialog box, log in as a Registered 
User or Guest User, or ask for permission.
The Exchange window is displayed. 
The left panel lists the drives, folders, and files 
on your computer. The right panel lists the same 
information for the remote computer.

4. Locate the desired files or folders and drag them 
from the source panel to the desired folder in 
the destination panel.

5. When you have finished exchanging files, close 
the Exchange window.



Using Control or Observe

You can use Timbuktu Pro to control or observe a remote computer. The desktop of the remote computer is dis-
played in a window on your screen. When you control another computer, you can perform any of the tasks that you 
can perform locally, including opening applications and creating new files. When you observe another computer, 
you can watch its screen but you cannot control it. 

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Control or Observe. Or click the Control or Observe service button. 
3. In the Log In dialog box, log in as a Registered User or Guest User, or ask for permission.

Timbuktu Pro displays the remote computer’s desktop in a screen-sharing window. With the Observe option, 
you will be able to observe the screen only; with the Control option, you can use your mouse and keyboard to 
operate the remote computer. Click on a screen-sharing window to make it the active window. To return to your 
own computer, click outside the screen-sharing window.

4. To stop controlling or observing, close the screen-sharing window. 

Using Chat

The Chat service lets Timbuktu Pro users post messages to one an-
other interactively. You may chat with more than one remote user 
simultaneously.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Chat. Or click the Chat service 

button. 
3. In the Log In dialog box, log in as a Registered User or Guest 

User, or ask for permission. The Chat window is displayed.
4. Type your first message and press Return or click Send .
5. Your message is copied to the transcript panel in the upper 

part of the window and to the remote computer’s Chat window.
6. The remote user’s reply is displayed below your message in 

the transcript panel. 
7. When you’ve finished chatting, click the Disconnect button. 

When either party disconnects, the session is ended
8. Click the Close button in the upper-right corner to close the 

chat window.

Using Notify

Timbuktu Pro’s Notify service lets you leave a request to be notified 
when another Timbuktu Pro computer becomes active. 

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Notify. Or click the Notify ser-

vice button.
3. In the Log In dialog box, log in as a Registered User or Guest 

User, or ask for permission. The Notify window is displayed. 
“Waiting for activity” appears near the top of the window.

4. While you’re waiting, you can work on tasks in other windows. 
You can minimize the Notify window, but don’t close it.

Timbuktu Pro will play a sound and bring the Notify window to the 
front when the remote user presses a key or moves the mouse.



Using Intercom

The Intercom service lets Timbuktu Pro users talk to each other 
through their computer’s audio hardware.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Intercom. Or click the Intercom  

service button. 
3. In the Log In dialog box, log in as a Registered User or Guest User, 

or ask for permission. The Intercom window is displayed.
4. Begin speaking with the remote user. 
5. You may click on other windows as you talk. The Intercom win-

dow does not automatically stay on top of the screen, but your 
Intercom connection will remain active.

6. When you’ve finished talking, click Close.

Using Invite

The Invite service allows you to invite other users to visit your com-
puter. Specify a user to receive your invitation, then select a service 
and send the invitation to the remote user. The recipient can use the 
service immediately or decline your invitation by closing the service 
window.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Invite. Or click the Invite button 

on the Button Bar.
3. In the Log In dialog box, log in as a Registered User or Guest User, 

or ask for permission. The Invite window is displayed.
4. In the Invite window, specify the service you wish to invite the 

other user to access. Then click Invite.
5. The Invite window appears on the remote computer, displaying 

the service you invited the visitor to use. The invited visitor may 
begin using the service or close the window to cancel it.

Using Profile

The Profile service allows you to generate a full system profile for the 
remote computer and save it as a text file on your Macintosh.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Profile. Or click the Profile button 

on the Button Bar. 
3. In the Log In dialog box, log in as a Registered User or Guest User, 

or ask for permission. The Profile window is displayed.
4. Specify a file name and location for the system profile to be 

saved on your local computer. Then click Save.

5. The system profile is generated on the remote computer and 
saved as a text file in the location you specified. When the pro-
cess is complete, the Profile window indicates that the profile 
has been saved and displays the file name.

Click the Open button to open the saved system profile in your default 
text editor.



Setting Up Incoming Access

Visitors have access to your computer only after you’ve enabled one or more of 
the transports in the Incoming Access dialog box. You may also quickly enable 
and disable incoming access by selecting transports in the Connection menu. 

1. From the Setup menu, choose Incoming Access.
2. In the Incoming Access dialog box, select or clear checkboxes to enable or 

disable incoming connections using each transport. Note that if you turn 
off a transport, you can still use that transport to make outgoing connec-
tions. Turning off a transport disables only incoming connections.

3. Close the Incoming Access dialog box.

Other Timbuktu Pro users can now establish connections to your computer 
over the selected transports. However, Timbuktu Pro will not accept Dial Direct 
calls until you grant Dial Direct access to selected visitors in the Define Users 
dialog box.

Assigning User Access Privileges

The Define Users dialog box allows you to specify the services available to 
Guest Users and Ask for Permission Users. It also allows you to create and 
manage your Registered Users. To open the Define Users dialog box, click the 
Setup menu and choose Define Users.

When you grant a service to Guest Users, any Timbuktu Pro user may access 
that service on your computer without entering a password. To grant services 
to Guest Users, select Guest and click Edit. Assign the desired services to 
Guest Users by clicking them.

Granting services to Ask for Permission users makes it possible for visitors to 
request that service on a one-time basis. When the user requests permission, 
you can choose whether or not to admit them. To grant services to Ask for Per-
mission users, select Ask for Permission and click Edit. Assign the desired ser-
vices to Ask for Permission Visitors by clicking them.

When you create a Registered User account, you assign the Registered User an 
identity and a set of access privileges. Registered Users can enter their user 
name and password to access your computer using any of the services you as-
signed to the Registered User account, anytime Timbuktu Pro is running on 
your computer. 

To add a new Registered User account, click the New button in the Define Us-
ers window. Then select the user type, enter the user name, specify a pass-
word (if required), and assign services.

• Mac OS X Users (and members of Mac OS X user groups) can make secure 
connections through SSH tunnels. They are known as System-
Authenticated Users because they are authenticated at the OS level, 
rather than by Timbuktu Pro. They require Timbuktu Pro version 8, as well 
as a Mac OS X user name and password on your computer. 

• Timbuktu Users use the same connection protocol used in previous ver-
sions of Timbuktu Pro. These Registered Users are authenticated by Tim-
buktu Pro when they connect. They may be using an older version of 
Timbuktu Pro, and they do not require Mac OS X access credentials on 
your computer.



Enabling the IP Locator

When you set up Timbuktu Pro, you may wish to enter your email address on the IP Locator tab in the Preferences di-
alog box. When you specify an email address here, it is registered with the Internet Locator Server. Remote users can 
then connect to your computer by entering your email address on the TCP/IP tab in the New Connection window. Us-
ers will not need to know your IP address to make the connection.

1. From the Setup menu, choose 
Preferences. 

2. On the IP Locator tab, enter your email 
address. 

3. Click the Advanced button to override 
the default Internet Locator server or 
default IP address for your computer.
Your network administrator will notify 
you if you need to change these set-
tings.

4. Click Save to save your changes. 

Your computer will be registered with the In-
ternet Locator Server.

Documentation and Online Help

The Timbuktu Pro Getting Started Guide is a comprehensive manual that covers installing, setting up, and using Tim-
buktu Pro. Timbuktu Pro’s comprehensive online Help provides a variety of ways to answer your questions. It con-
tains step-by-step instructions for all common procedures, as well as troubleshooting hints, keyboard shortcuts, 
and a glossary. To open the online Help, click the Help menu and choose Timbuktu Help. If a Help button is available 
in a window or dialog box, click it to display the online Help topic associated with that window. 

Technical Support

If you require technical support, please browse Netopia’s Technical Notes and Frequently Asked Questions, avail-
able 24 hours a day on our Web site at http://www.netopia.com/support/. Most common questions and problems 
are addressed here. 

If you are unable to resolve your issue using our online technical support, please use our online email form to send 
us a message. The form is at http://www.netopia.com/support/contact_us.html.

You can contact Netopia Customer Service on the Web, or by mail or fax:

Mail: 

Netopia Customer Service
6001 Shellmound Street
Emeryville CA 94608 
USA

Fax: (510) 420-7609
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